OLYMPUS'

DIGITAL VOICE
RECORDER

DS-330

ON LINE
INSTRUCTIONS

Thank you for purchasing an Olympus
Digital Voice Recorder.
Please read these instructions for information about using
the product correctly and safely.
Keep the instructions handy for future reference.

To ensure successful recordings, we recommend that
you test the record function and volume before use. EN




For Safe and
Correct Usage

Before using your new recorder, read this

manual carefully to ensure that you know

how to operate it safely and correctly. Keep
this manual in an easily accessible location
for future reference.

* The warning symbols indicate important
safety related information. To protect yourself
and others from personal injury or damage to
property, it is essential that you always heed
the warnings and information provided.

General Precautions

® Do not leave the recorder in hot, humid
locations such as inside a closed
automobile under direct sunlight or on the
beach in the summer.

@ Do not store the recorder in places exposed
to excessive moisture or dust.

@ Do not use organic solvents such as alcohol
and lacquer thinner to clean the unit.

@ Do not place the recorder on top of or near
electric appliances such as TVs or
refrigerators.

@ Avoid recording or playing back near
cellular phones or other wireless equipment,
as they may cause interference and noise.
If you experience noise, move to another
place, or move the recorder further away
from such equipment.

® Avoid sand or dirt. These can cause
irreparable damage.

@ Avoid strong vibrations or shocks.

@ Do not disassemble, repair or modify the
unit yourself.

@ Do not operate the unit while operating a
vehicle (such as a bicycle, motorcycle, or
go-cart).

@ Keep the unit out of the reach of children.

IBM and PC/AT are the trademarks or registered
trademarks of International Business Machines
Corporation.

Microsoft and Windows are registered trademarks
of Microsoft Corporation.

Intel and Pentium are registered trademarks of
Intel Corporation.

Adobe and Acrobat Reader are registered
trademarks of Adobe Systems Incorporated.

CORTOLOGIC is a registered trademark of
Cortologic AG.

Apple, Macintosh, iMac, Mac, and PowerMac
are trademarks or registered trademarks of
Apple Computer, Inc.

Other product and brand names mentioned
herein may be the trademarks or registered
trademarks of their respective owners.



Batteries

AC Adapter

/A\Warning

e Batteries should never be exposed to
flame, heated, short-circuited or
disassembled.

* Do not attempt to recharge alkaline,
lithium or any other non-rechargeable
batteries.

* Never use any battery with a torn or
cracked outer cover.

e Keep batteries out of the reach of
children.

¢ If you notice anything unusual when
using this product such as abnormal
noise, heat, smoke, or a burning odor:
(@ remove the batteries immediately while

being careful not to burn yourself, and;
@call your dealer or local Olympus
representative for servicing.

/A\Warning

* Do not attempt to disassemble, repair or
modify the AC adapter in any way.
* Keep foreign objects including water,
metal, or flammable substances from
getting inside the product.
* Do not moisten the AC adapter or touch
it with a wet hand.
* Do not use the AC adapter in the vicinity
of flammable gas (including gasoline,
benzine and lacquer thinner).
In case
e ... the internal parts of the AC adapter are
exposed because it has been dropped or
otherwise damaged:
e ... the AC adapter is dropped in water, or
if water, metal flammable substances or
other foreign objects get inside it:
e ... you notice anything unusual when
using the AC adapter such as abnormal
noise, heat, smoke, or a burning odor:
(@ do not touch any of the exposed parts;
(2 immediately disconnect the power supply
plug from the power outlet, and;

®call your dealer or local Olympus
representative for servicing. Continued
use of the AC adapter under these
circumstances could result in electric
shock, fire or injury.



Main Features

® The recorder stores highly compressed
DSS format voice messages in 16 MB
integrated flash memory.

® The recorder supports two recording modes,

SP (Standard Playback) mode or LP (Long

Playback) mode. (x= P.18)

* Continuous recording time is approximately 2
hours and 35 minutes in SP mode and
approximately 5 hours and 30 minutes in LP
mode.*!

® The five folders can hold 199 files each,
for a maximum of 995 recordings. (= P.12)

@ You may assign your own names to folders.
(= P.32)
* Each of the 5 folders can have a name of up to
8 characters.
* This recorder has 10 pre-set name templates.

® Recorded files may be moved from one
folder to another. (s P.36)

® Has a built-in Variable Control Voice
Actuator (VCVA) function. (= P.16)

® You can insert or delete index marks.
(= P.27)
« If you insert index marks during recording or
playback, you will later be able to quickly find
the recording you want to hear.

® The recorder has a Noise Cancel Function.
(= P.23)
* Cortologic AG Noise Suppression Technology
reduces noise in files and enables clear sound
playback. CORTOLOGIC

=

® You can input file comments. (= P.35)
* You can add comments of up to 100 characters
to each recorded file.
*This recorder has 10 pre-set comment
templates.

@ It has a large backlight full-dot display (LCD
display screen).
* The screen displays information about recorded
voice files and easily understood operational
messages.

® It has Fast Playback and Slow Playback
functions to control playback speed.
(= P.21)

@ If you connect the recorder to a computer,
you can use it as a USB microphone or
USB speaker.*? (== P.69)

® Comes with DSS Player software. (= P.42)
« If you transfer voice files recorded with the recorder

toa PC, you can easily play back, organize, and edit
the files.

® Connect the included USB cable to your
computer for faster transmission speed.

It comes with a special cradle for convenient
connection to a PC.

*1: Available recording time for one continuous file.
Available recording time may be shorter if many
short recordings are made. (The displayed
available recording time and recorded time are
approximate indications.)

*2: Do not use with Windows 98 as computer
operation may become unstable.
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Identification of Parts

(D Built-in microphone

(2 Record/Play indicator lamp
(@ Microphone jack

(@ VOLUME control

(5 NEW button

(® REC (Record)/SET button
(@ INDEX button

REW (Rewind) /- button

(© FF (Fast Forward) /+ button
FOLDER/MENU button

@) HOLD switch

(2 Built-in speaker

(13 STOP button

ERASE button

3 PLAY button

DISPLAY button

@ Display (LCD panel)

PC (USB) terminal

Cradle connection terminals

Battery cover

@) Strap hole

@2 Earphone jack

@ Power jack

MICSENS (Microphone sensitivity)
switch

@ Cradle attachment point



Display (LCD Panel)

2997

© Battery indicator

@ Alarm indicator

© VCVA(Variable Control Voice
Actuator) indicator

O Record mode indicator

O Folder

O Current file

@ Erase lock indicator

© Character Information display

sued Jo uoneoynuap|
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Inserting Batteries

Lightly press down on the arrow and slide the
battery cover open.

2 Insert two AAA alkaline batteries, observing
the correct polarity.

2 3 Close the battery cover completely.

Replacing batteries
The battery indicator on the display changes as the batteries

lose power.
3 aw) - O > T3 - )
“BATTERY
Low”

When {C_¥J appears on the display, replace the batteries as
soon as possible.

When the batteries are too weak, the recorder shuts down
and “BATTERY LOW” appears on the display. AAA alkaline
batteries are recommended.

Notes

* Be sure to stop the recorder before replacing the batteries. Unloading the batteries while the recorder is
recording, erasing or otherwise accessing an audio file may corrupt the file. If you are recording into a file and
the batteries run out, you will lose your currently recorded file because the file header will not be able to close.
So, it is crucial to change the batteries once you see only one mark in the battery icon

* Be sure to replace both batteries at the same time.

* Never mix old and new batteries, or batteries of different types and/or brands.

« If it takes longer than 1 minute to replace dead batteries, you may have to reset the time when you load fresh
batteries. (v= P.10)

* Remove the batteries if you are not going to use the recorder for an extended period of time.



Using the AC Adapter

Plug the optional AC adapter (Olympus Model
A321 or A322) into household power outlet and
connect the power plug to the recorder’s power
connector (DC 3 V) as shown in the illustration.
Always stop recording before connection.
Otherwise it may not be possible to play back
the voice data being recorded.
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* Always stop recording before connection
or disconnection.

* When the AC adapter is not in use,
disconnect the power supply plug from
the power outlet.

* Use only the correct power supply voltage
as indicated on the adapter.

*Do not use the AC adapter when
connecting the recorder to the USB port.

Hold

Setting the HOLD switch to the HOLD
position.

If you set the recorder to HOLD status by sliding
the HOLD switch in the direction of the arrow, the
current conditions will be preserved, and all buttons
and switches except the HOLD switch will be
disabled. This feature is useful when the recorder
has to be carried in a bag or pocket.
Remember to reset the HOLD switch when
using the recorder.

Notes

* |f you set the recorder to hold during Stop mode,
the display goes dark. If you press any button, the
time will flash for about 2 seconds, but the function
of the button is disabled.

* The alarm will sound at the scheduled time even if
the recorder is set to hold. The recorder begins to
play the file associated with the alarm when you
press any button.

* |f you are recording when you switch the recorder
to HOLD, recording will continue until the recorder
memory runs out.

PIoH / 1e1depy 9y ay) Buisn



Setting Time/Date

If you have set the time and date, information as to when an audio file is recorded is stored
automatically with that file. The time and date should be set to ease file management tasks. The

time and date setting is also needed to perform the alarm playback function. (x== P.28)

from step 3.

The hour indicator will flash automatically when you load batteries before using the
recorder for the first time, or after the recorder hasn't been used for a long time. Proceed

sjeq/owil bunes

Time/Date Screen

DISPLAY
button
(switching the
data displayed)

REC/SET
button
(accepts a choice
and moves on to
the next item)

FF/+ or
REW/- button

(alters a choice)

FOLDER/
MENU
button

Changing the Time/Date

1

Press and hold the FOLDER/
MENU button for 1 second or
longer.

The menu opens. (= P.41)

Press the FF/+ or
REW/- button until
“TIME&DATE ”
flashes on the
display.

Press the REC/SET button.

Time/Date screen appears. The hour

indicator flashes, indicating the start of

the Time/Date setup process.

* You can choose between 12 and 24
hour display by pressing the DISPLAY
button while setting the hour and minute.

Example: 5:45 P.M.
PM 5:45 «— 17:45



Set the hour.

@ Press the FF/+ button or REW/-
button to set the hour.

(@ Press the REC/SET button to accept
the hour.

Set the minute.

@ Press the FF/+ button or REW/-
button to set the minute.

(@ Press the REC/SET button to accept
the minute.

Set the year.
@ Press the FF/+ button or REW/-
button to set the year.
(@ Press the REC/SET button to accept
the year.
* You can choose the order of the year,
month, day by pressing the DISPLAY
button while setting them.

Example: March 14, 2002

3M 14D '02Y (Initial setting)
2

14D 3m 02y
2

'02y 3m 14D

Set the month.

@ Press the FF/+ button or REW/-
button to set the month.

(@ Press the REC/SET button to accept
the month.

Set the date.

@ Press the FF/+ button or REW/-
button to set the date.

(@ Press the REC/SET button to
accept the date.

This completes the Time/Date setup
procedure.

9 Press the STOP button to end.

If you press the STOP button during the setup

operation, the clock will use the items that were set

to that point.

ajeqg/owi] Bumes
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Recording

The recorder provides five folders, [Al, [B], [C], [D] and [E], and each message recorded in a folder
is saved as a Digital Speech Standard (DSS) file. These five folders can be selectively used to
distinguish the kind of recording; for example, [A] might be used to store private information, while
might be dedicated to holding business information (== P.32). Up to 199 messages can be
recorded per folder. Four recording modes are available: new, append, overwrite, and insert.

New Recording
Create a new file to record in.

Microphone 1 Press the FOLDER/MENU button
to choose a folder.

The folder name is displayed for

approximately 2 seconds.

@ Folder name

Buipiooay

(o Total number of recorded files in the
folder
Press the NEW button to create a
3 new file.
© New file number
@ Current recording mode
1 (® Remaining recording time
Press the REC/SET button to start C= T
. SP(73%)
recording. =11
The record/play indicator lamp glows red. Benas
Aim the microphone at the sound source. RECORD
(® Current recording time 3
@ Remaining recording time =0 00
EEL
Press the STOP button to stop ~ 7oc [REHETH%S
recording. @r——=dunl

If you want to append additional recordings to the same
file, press the REC/SET button once again.



Notes

* A beep will sound when remaining recording time
reaches 60 seconds, 30 seconds, and 10 seconds
while recording.

* “MEMORY FULL” or “FOLDER FULL” will be
displayed when the memory or file capacity is full.
Delete any unnecessary files before recording any
further(r== P.24) or transfer voice files to your
computer using DSS Player Software. (== P.42)

* You cannot select a different mode than that of
the original file before append recording. (= P.18)

Pause Recording

Press the REC/SET button while recording.
W “REC PAUSE” will flash on the display.

| Resume Recording |
Press the REC/SET button again.
w» Recording will resume at the point of
interruption.

Note
The recorder stops when it has been left
paused for 10 minutes or longer.

To instantly review a recording

(Quick review)

Press the REW/- button while recording, and
release it when you want to start playing a file.
The recorder plays up to the quick review point,
then stops.

You can append additional recordings in the
same file from that point.

Listening While Audio Is Recorded

(Recording Monitor)

Insert the earphone into the earphone jack to
monitor what is being recorded. (Volume can
be controlled using the Volume control.)

To see the remaining recording time

The remaining recording time
appears on the display when
the recorder is stopped and
the STOP button is pressed.

LEEMHIH]
oanifs
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Overwrite Recording

You can overwrite a previously recorded file from any point within the file.
Note that the overwritten recordings will be erased.

Choose and play the file you want
to overwrite.

want to start overwriting.

(@ Current playback time
(© Total recording time of the file being

1 played

2 Press the STOP button where you

Press the REC/SET button to start
1 overwriting.

Press the STOP button to stop
overwriting.

Notes
* You can pause and resume overwrite recording by pressing the REC/SET button.

The record/play indicator lamp glows red.

~ O

FOLDER A

TOTAL 134

@——RAngls
[LEH
®1—1H53n18:

* You cannot select a different mode than that of the original file before overwrite recording. (= P.18)



Insert Recording
Additional recordings can be inserted into previously recorded files.

1 Choose and play the file you want =0
to insert. FOLDER
TOTAL 134
3
While playing a file, press the ~g | 8
FOLDER/MENU button if you want LT T S
to insert additional recording. IHEEETS
“INSERT REC?” appears on the display. RECY

inserting additional recording.

As insert recording progresses, remaining
memory grows smaller.

(@ Remaining recording time

3 Press the REC/SET button to start

Press the STOP button to stop
inserting additional recording.

Notes
* You can pause and resume insert recording by pressing the REC/SET button.
* The recording time and date of the file into which recording has been inserted is updated to the time and date

of when the inserted recording was recorded.
* You cannot select a different mode than that of the original file before insert recording. (== P.18) ]5
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Using the Variable Control Voice Actuator (VCVA)

When the microphone senses that sounds have reached a preset volume, the built-in Variable

Control Voice Actuator (VCVA) starts

recording automatically, and stops when the volume drops.

Particularly helpful for extended recording, the VCVA not only conserves memory by turning off
recording during silent periods, but also makes playback more efficient and convenient.

1

2
35 9
24
1

)
b

Press and hold the FOLDER/MENU
button for 1 second or longer.
The menu opens. (= P.41)

Press the FF/+ or REW/- button
until “VCVA” flashes on the
display.

Press the REC/SET button.

The VCVA setup process begins.

Press the FF/+ or REW/- button to -[&2
choose between ON and OFF. imUEUH
ON : Will start recording in VCVA mode. }

OFF : Will resume recording in normal R

mode.

Press the REC/SET button to
complete the setup screen.

Press the STOP button to close the
menu.

When ON is selected, a @ indication will be
displayed on the screen.



7 Start the recording.

When the sound volume is lower than the =0

preset pause sound level, recording ot 58
automatically pauses after approximately HBmals
1 second, and “STANDBY” flashes on the
display. The record/play indicator lamp
glows when recording starts and flashes
when recording pauses.

Adjust the start/stop actuation level

Using the VOLUME control, adjust the start/stop
actuation level.

The pause sound level can be set to any of 15 different
values. The higher the value, the higher the sound sensitivity.
At the highest setting, even a small sound will activate
recording.

The VCVA pause sound level can be adjusted according to the
ambient (background) noise.

Notes
* The start/stop actuation level also varies depending on the selected microphone sensitivity mode. (= P.19)
* To ensure successful recordings, prior testing and adjustment of the start/stop actuation level is recommended.

(VADA) 101Nn10Y 82107 [043U0D 3|qerieA ayy Buisn
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Recording Modes (REC MODE)

You can choose between two recording modes: SP (Standard Playback) mode and LP (Long
Playback) mode. Once you choose a mode, files are recorded in the selected mode as long as you

do not change the mode.

The included 16MB integrated flash memory holds approximately 2 hours and 35 minutes in SP
mode and approximately 5 hours and 30 minutes in LP mode. Available recording time for one
continuous file. Recording time may be shorter if many short recordings are made.

24 2

53
4

Notes

Press and hold the FOLDER/
MENU button for 1 second or
longer.

"REC MODE" will be displayed on the
screen.

Press the REC/SET button.
The recording mode setup process
begins.

Press the FF/+ or REW/- button
to choose between SP and LP.

&~

REC MODE
Lr

Press the REC/SET button to
complete the setup screen.

Press the STOP button to close the
menu.

* Choose SP mode for recording meetings or lectures with crisp clarity.
* You cannot select a different mode than that of the original file before append, overwrite, or insert recording.

(= P.14-15)

* Use SP mode in conjunction with voice recognition software. (= P.65)



Microphone
Sensitivity

Microphone sensitivity is adjustable to meet
recording needs.

SN3ISOIN

Using the MICSENS switch, choose
between the CONF and DICT positions.

CONF : High-sensitivity mode that records

sounds in all directions.

DICT : Low-sensitivity mode suited for

dictation.

Notes

* If you want to clearly record dictation, switch to
DICT mode and place the internal microphone
close (5 to 10 cm) to the speaker.

* |f the ambient (background) noise is too loud to
get a clear recording even in DICT mode, we
recommend that you use an ME-12 single
directional microphone (sold separately).

Aunmsuag auoydouaipy
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Playing

You can start playing a file at any point.

Press the PLAY button to start

playback.

The record/play indicator lamp glows

green.

(@ Current playback time

® Total recording time of the file being
played

Adjust the VOLUME control to
your liking.

N\
(4
O

—

Press the STOP button at any
3 point you want to stop the
playback.
Resume playback by pressing PLAY
button again.

20



Playback Operation How to Cancel
functions
Fast Press the PLAY button once while playing  Press the PLAY button 2 times while fast
Playback  afile. playing back.
(F.PLAY) — The recorder plays back at approximately ~— Playback returns to normal rate.
50% faster than normal rate.
Slow Press the PLAY button once while fast Press the PLAY button once while slow playing
Playback  playing back. back.

(S.PLAY) — The recorder plays back at approximately ~— Playback returns to normal rate.
25% slower than normal rate.

Fast Press the FF/+ button once while stopped. Press the STOP button.

Forward — (If the FF/+ button is pressed at the end of — The recorder stops immediately.

(FF) a file, the recorder stops at the beginning (If you do not press the STOP button, the
of the next file. And if the FF/+ button is recorder will reach the end of the file and
pressed within 2 seconds, the recorder then stop automatically.)
skips to the beginning of the next file.)

Rewind Press the REW/- button once while stopped.  Press the STOP button.

(REW) — (If the REW/~ button is pressed at the — The recorder stops immediately.
beginning of a file, the recorder starts (If you do not press the STOP button, the
rewinding from the end of the previous file.) recorder will reach the beginning of the file and

then stop automatically.)

Cue Hold the FF/+ button while stopped or Release the FF/+ button.

(CUE) playing a file. — The recorder will resume playback.

(If you do not release the FF/+ button, the
recorder will reach the end of the file and then
stop automatically.)

Review Hold the REW/- button while stopped or Release the REW/- button.

(REV) playing a file. — The recorder will resume playback.
(If you do not release the REW/- button, the
recorder will reach the beginning of the file and
then stop automatically.)

« If you press the FF/+ button once while fast-forwarding or twice while stopped, the recorder will stop at the end
of the file.(F.SKIP)

« If you press the REW/- button once while rewinding or twice while stopped, the recorder will stop at the
beginning of the file (B.SKIP). If the REW/- button is pressed within 2 seconds, the recorder skips to the
beginning of the previous file.

Note

If you set Noise Cancel to “LOW” or “HI”, you cannot use the Fast Playback and Slow Playback functions.

(= P.23)

Buifeld
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Continuous Playback (ALL PLAY)

When a file finishes playing back, the next file is played without stopping until it reaches the last file

in the folder.

2
3,9

2,4
4

)
b

Press and hold the FOLDER/
MENU button for 1 second or
longer.

The menu opens. (= P.41)

Press the FF/+ or REW/- button
until “ALL PLAY” flashes on the
display.

Press the REC/SET button.

The Continuous Playback setup process
begins.

Press the FF/+ or REW/- button
to choose between ON and OFF.

ON : Continuous playback.
OFF: Returns to normal playback mode.

Press the REC/SET button to
complete the setup screen.

Press the STOP button to close the
menu.

fLL PLRY
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Noise Cancel Function

If recorded sound is difficult to hear because of noisy surroundings, adjust the Noise Cancel setting
level. Noise will be reduced in the file when it's played back for clearer sound quality.

Press and hold the PLAY button

1 for 1 second or longer while the
file is playing.
Displays currently set Noise Cancel level.

noise cancel level.
Each time you press the PLAY button, the
display changes as follows.

2 Press the PLAY button to choose a

OFF : (Initial Setting)
1 3

LOW : Reduces noise.
1

HI  : Reduces more noise.

If the display is already set to Noise Cancel, start from step 2.

Change the Noise Cancel level within 8 seconds, otherwise the level is
set at the displayed level and the display returns to its original view.

Notes

* If you set Noise Cancel to "LOW" or "HI", the setting remains valid until it's set to "OFF".

* |f you set it to "LOW" or "HI", the display flashes the Noise Cancel level for about 2 seconds when a file is
played back.

* |f you use the Fast Playback and Slow Playback function,you cannot set Noise Cancel to "LOW" or "HI".
(= P.21)

uoiauN4 [99uUB) 9SION
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Erasing

Erasing One File at a Time

A selected file can be erased from a folder.

1 Press the FOLDER/MENU button =0

to choose a folder. .
The folder name is displayed for EOLDEE B

approximately 2 seconds. TOTAL 134

Press the FF/+ or REW/- button
to choose the file you want to
erase.

Press the ERASE button.
“FILE ERASE?” flashes on the display for @
2 approximately 8 seconds.

(@ File to be erased

Buiseig

1 Press the ERASE button once more
4 when “FILE ERASE?” is flashing.
The display changes to "FILE ERASE!"
and erasing will start.

“ERASE DONE” is displayed when the file is
erased. File numbers are incremented
automatically.

Notes
« |f the ERASE button is not pressed within the 8 seconds after “FILE ERASE?” starts flashing, the recorder will
revert to stop status.
* An erased file cannot be restored.
24 * Locked files cannot be erased. (== P.26)



Erase All Files from a Folder

All files in a folder can be erased simultaneously, except for locked files. (= P.29)

Press the FOLDER/MENU button
1 to choose the folder you want to

erase all files.

The folder name is displayed for

approximately 2 seconds.

(@ Folder from which to erase files

Press the ERASE button for 3
2 seconds or longer.
“ALL ERASE?” flashes on the display for
approximately 8 seconds.

Press the ERASE button once more

3 when “ALL ERASE?” is flashing.
The display changes to “ALL ERASE!”
and erasing will start.

“ERASE DONE” is displayed when the files are
erased. Locked files are reassigned file
numbers in ascending order.

TOTAL 134

nnnnn

Notes

« |f the ERASE button is not pressed within the 8 seconds after “ALL ERASE?” starts flashing, the recorder will

revert to stop status.

* |t might take more than 10 seconds to complete erasing all files.

Buiseig
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Locking Files (LOCK)

Locking a file keeps important data from being accidentally erased.

Locked files are not erased when you choose to erase all files from a folder. (= P.25)
Press the FOLDER/MENU button to
choose a folder.

Press the FF/+ or REW/- button to
choose the file you want to lock.

Press and hold the FOLDER/MENU
button for 1 second or longer.

(%207 sali4 Bunjoo]

5 The menu opens. (== P.41)
) 4 Press the FF/+ or REW/- button =
until “LOCK” flashes on the display.
946 pay.
) Press the REC/SET button. EI:ERQL oy
The file locking setup process begins.
1 ,3 Press the FF/+ or REW/- button to
choose between ON and OFF. ®- =0 g
ON : Locks the file and prevents it from Lokl |
being erased. L
OFF : Unlocks the file and allows it to be Cee T
erased.

(@ File to be locked
(® Erase lock indicator

Press the REC/SET button to complete
the setup screen.

Press the STOP button to close the
menu.

Notes
* You cannot append, overwrite, or insert recordings into locked files. (== P.12-15)
* You cannot set index marks in locked files. (= P.27)

26 * Any locked files are erased when you format the recorder. (= P.40)




Index Marks

Index marks can be incorporated into a file during recording or playback to make it easy to locate
interesting information.

Setting an Index Mark

Press the INDEX button during

1 recording or playback to set an
index mark.
An index number appears on the display.

Locating an Index Mark

Hold the FF/+ or REW/- button
1 while playing a file.
The recorder stops for 1 second when it
reaches the index mark.

syIe Xopu|

Clearing an Index Mark

Locate the index mark you want to
clear.

Press the ERASE button while the
2 index number appears for
approximately 2 seconds on the
display.
The index mark is erased.

Notes

* Up to 16 index marks can be set in a file. Attempting to set more index marks will cause “INDEX FULL” to
appear on the display.

* Index marks cannot be set or cleared in a locked file. (= P.26) 27
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Alarm Playback Function (ALARM)

The alarm playback function can be set to play a selected file at a pre-set time.

Press the FOLDER/MENU button
to choose a folder.

to choose the file to be played
when the alarm sounds.

Press and hold the FOLDER/
5 MENU button for 1 second or

longer.

The menu opens. (= P.41)

2,4,6 4 Press the FF/+ or REW/- button

2 Press the FF/+ or REW/- button

until “ALARM?” flashes on the

1 , 3 display.

Press the REC/SET button.
The alarm playback setup process begins.

Press the FF/+ or REW/- button
to choose between ON and OFF.

ON : Enables alarm playback.
OFF: Disables alarm playback.

@ File to be played when alarm sounds
(® Alarm indicator



Press the REC/SET button to

7 complete the setup screen.
When you choose ON, the hour
indicator flashes.
When you choose OFF, the alarm
indicator disappears and finishes with
Step 12.

Press the FF/+ or REW/- button
to set the hour.

7,9,11 Press the REC/SET button to
accept the hour.
The minute indicator flashes.

8,10 4 A Press the FF/+ or REW/- button
to set the minute.

4 4 Press the REC/SET button to
accept the minute.

the menu.

4 2 Press the STOP button to close

An alarm tone will sound at the scheduled time. Press any button
while the alarm sounds to play the file you associated with the alarm.

Notes

* The alarm playback function can be set for only one file at a time.

* The alarm will sound at the scheduled time every day unless the alarm playback setting is cleared.

* |f you wish to change the file for alarm play, first turn the alarm settings “OFF”, then make any desired new
alarm settings.

* The alarm will sound for 5 minutes and then stop.

* If you are using the recorder at the scheduled time, the alarm will sound after you're done.

* The alarm will sound at the scheduled time even if the recorder is set to hold. The recorder begins to play the
file associated with the alarm when you press any button.

* The alarm playback setting is cleared if the selected file is erased.

(WYV1VY) uonoung yoegAeld wiey
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LCD Contrast Adjustment (CONTRAST)

If the display is difficult to see because of environmental conditions and temperature, you can
adjust the contrast using this function to easily see the LCD display (display contrast).
Display contrast can be adjusted in 10 levels.

3,9 2

!

)
b

Press and hold the FOLDER/
MENU button for 1 second or
longer.

The menu opens. (= P.41)

Press the FF/+ or REW/- button
until “CONTRAST” flashes on the
display.

Press the REC/SET button.
The LCD display contrast setup process
begins.

Press the FF/+ or REW/- button
to set the contrast level.

You can adjust the LCD display contrast
level from 1 to 10.

(Initial setting ...... 6)

Press the REC/SET button to
complete the setup screen.

Press the STOP button to close the
menu.



Backlight (BACKLIGHT)

The backlight for the recorder will be activated for approximately 10 seconds each time a button

is pressed. You can select whether or not you would like to use the backlight.

g5 2
94 3
1 4

)
b

Press and hold the FOLDER/
MENU button for 1 second or
longer.

The menu opens. (= P.41)

Press the FF/+ or REW/- button
until “BACKLIGHT” flashes on the
display.

Press the REC/SET button.

The backlight setup process begins.

Press the FF/+ or REW/- button
to choose between ON and OFF.
ON : Backlight is enabled.
OFF: Backlight is disabled.

Press the REC/SET button to
complete the setup screen.

Press the STOP button to close the

menu.
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Assigning Folder Names (FolderName)

You can give each of the five [A] to [E] folders a name with up to 8 characters.
Frequently used words such as "dictation (DICT.)", "meeting (MEETING)" and "schedule
(SCHEDULE)" are pre-set in a template.

Press and hold the FOLDER/
MENU button for 1 second or
longer.

The menu opens. (= P.41)

Press the FF/+ or REW/- button
until “FolderName” flashes on the

3, 5 display.

3 Press the REC/SET button.
2,46

The folder name setup process begins.

>

)

Q

3.

=3

‘2" Press the FF/+ or REW/- button =

g 1 to choose the folder you want to FolderNane
z name. FOLDER A
3

3

T 5 Press the REC/SET button to =0

g accept the chosen folder. FolderHane
E FOLDER A
2

Press the FF/+ or REW/- button
to choose characters.

The recorder assigns the following
buttons to inputting procedures.
(Available characters = P.34)

32



Recorder buttons that are used to input characters

Button Push Action

REC/SET | Press once To input the selected character and advance the input position.

Press and hold | Confirms folder name or file comment.

FF/+ Press once Selects character to be input: forward.

Press and hold | Skips forward quickly through characters.

REW/- | Press once Selects character to be input: back.

Press and hold | Skips back quickly through characters.

NEW  |------mme- Returns to previous character.
ERASE |---------- To delete the flashing character.
INDEX | Press once Switches between character groups (type).

Press and hold | Quickly cycles through the character groups (types).

DISPLAY |Press once Selects character to be input: skips ahead by 5 characters.

Press and hold | Quickly skips ahead in increments of five characters.

Use the two following methods to quickly find characters.

1. When the INDEX button is pressed, the displayed character group (example: Uppercase,
lowercase, template, symbols) will change, and you can then press the FF/+ or REW/- buttons
to select characters.

2. Every time the DISPLAY button is pressed, it will skip ahead by five characters, so you can
quickly move closer to the character you want.

(Currently displayed character) = (Space) - DICT. - TODO -A—+F—+K—-+P—->U—+Z—+>a—f—
k-p—-u—>z—-+1—-6—>,—>(—>}—+$ — *— (Space) = DICT. -~ TO DO...

If you press the DISPLAY button while a character other than one of the above appears, you will skip to the
closest forward character in the above cycle.
Pressing the DISPLAY button again will then cycle through every fifth character as shown above.

example:
If you press the DISPLAY button while “MEMO” is displayed, “TO DO” will appear.
If you press the DISPLAY button while “B” is displayed, “F” will appear.

(aweNJap|o4) sawep Jap|o4 Bulubissy



Available characters

Type of Characters Action
Template Folder name input | DICT. = MEETING — MEMO — NOTE — IDEA —TO DO —
REMINDER — LECTURE —~SCHEDULE — ARCHIVE
File comment TOP PRIORITY — PRIORITY — IMPORTANT —
input CONFIDENTIAL — PRIVATE — DON'T FORGET —THINGS
TO DO —-MESSAGE — CONVERSATION —REPORT
Large caps A—-B—+C—D—E »F—>G—+H—>I->J—>K—>L—>M—N—
0—-P—-Q—+R—+S—>T>U—>V>W—>X—>Y—>Z
Small caps a—+b—+c—d—+e >f+g—>h—>i—>j—>k—>I->m—-n—o0—
p—»q—»r—»s—»t—»u—»v—»w—»x—»y—»z
Numerics 1—+2—-+3—+4—-5 —+6—+7—-8—>9—0
Symbo|s ,—>_—>;—>!—>_—>(—>)—>[—>]—>{—>}—>+
> - =2 # >8> %> &> "> > > @

When you have finished setting the folder
name, press and hold the REC/SET button for
1 second or longer.

This completes the folder naming procedure.

(If you wish to continue assigning names to folders,
press the REC/SET button and repeat the procedure
from step 4.)

8 Press the STOP button to close the menu.

(awepNJap|o4) saweN Japjo4 Bulubissy

Notes
* The folder naming process ends automatically when the eighth character is set.
* |f you input more than 8 characters, "OVERFLOW" appears on the display.

34 « You can use a PC to easily change the folder names on the recorder. (5 P.63)



Assigning File Comments (COMMENT)

You can add comments of up to 100 characters to each recorded file.

If you include the date, time, and other information, you can easily find files without replaying

them.

2
39 3
2 4

b

Press and hold the FOLDER/
MENU button for 1 second or
longer.

The menu opens. (= P.41)

Press the FF/+ or REW/- button
until “COMMENT” flashes on the
display.

Press the REC/SET button.
The file comment setup process begins.

Input the character.

If you will input characters using the
recorder, see step 6 of “Assigning Folder
Names”. (= P.32)

If you will input characters using a
computer, see “Editing File Comments”.
(= P.63)

When you have finished setting
the file comments, press and hold
the REC/SET button for 1 second
or longer.

This completes the file comment input
procedure.

Press the STOP button to close the
menu.

P ]
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Moving Files Across Folders

A recorded file can be transferred from one folder to another.
The file is added at the end of existing files in the destination folder.

Choose the file you want to move
and play it.

Press the FOLDER/MENU button
while playing the file.
4 “INSERT REC?” appears on the display.

3 Press the FOLDER/MENU button

The destination folders blink on the
display.

(@ File to transfer

(® Current folder

(© Destination folder

1 5253 4 Press the REC/SET button.

again to change to “FILE MOVE?”.

~n

FILE MO

~ 0

FILE f0

—d

[Jx]
a8

WE?

i

UE?




to choose a destination folder.

If you choose the current folder as the
destination folder, the selected file will
move to the end of the existing files in it.

Press the REC/SET button to
6 accept the chosen destination

folder.

The file is moved.

5 Press the FF/+ or REW/- button

Transfer is complete when “FILE MOVE DONE”
appears.

[SS[A]
[}

[ 55

FILE MOUE!

MR

Notes

« If the destination folder is full (a maximum of 199 files), “FOLDER FULL” appears on the display and files

cannot be transferred to it.

* The file transfer process is aborted if you press the STOP button or leave the recorder idle for 8 seconds after

you choose a destination folder.

S19p|04 SS049Y S3|i4 Buinopy
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System Sounds (BEEP)

The recorder beeps to alert you to button operations or warn you of errors. System sounds may be

turned off.

2
3,9 3

24 4

)
b

Note

Press and hold the FOLDER/
MENU button for 1 second or
longer.

The menu opens. (= P.41)

Press the FF/+ or REW/- button
until “BEEP” flashes on the
display.

Press the REC/SET button.

The system sound setup process begins.

Press the FF/+ or REW/- button
to choose between ON and OFF.
ON : System sounds are enabled.
OFF: System sounds are disabled.

Press the REC/SET button to
complete the setup screen.

oD HULLU
IIME&LHIE

Press the STOP button to close the
menu.

If the alarm playback function has been set, the alarm will sound at the scheduled time even if system sounds

are turned off.



LCD Display Information

This recorder is capable of switching views on its LCD display. If you press the DISPLAY button
while stopped or while playing back a file, the LCD display will switch and you can confirm file
information and various recorder settings.

Press the DISPLAY button.
The LCD display views will switch every time the DISPLAY
button is pressed.

While stop or playback mode

It will repeatedly cycle through @ to @.

a1 @File length
SP( o
i ggma'a'f Shows how long a file is.
[LENGTH]
| IHogmiss
2
sl — @ Time stamp
BAnAAS Shows the year, month, and date that
[REC DHTE] the file was recorded.
1Zndlp* 82y
2
T © Time stamp |
BARBAS Shows the time that the file was
[REC TIME] recorded.
Am12:58
2
=a,___1 @ File comment*
— @gmaaé Shows comment added to a file.
[COMMENT] (If there is no comment, “----" will
T appear.)

* If a comment contains many characters, it will scroll horizontally to display the complete comment.

uonewuoyu] Aejdsia ao
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Formatting the Recorder (FORMAT)

If you format the recorder, all function settings will return to their defaults*.

All files** stored in the recorder will be deleted.

If you have important files that you want to save, connect the recorder to a computer and transfer
those files from the recorder to the computer before formatting the device. (== P.55)

* Date and time settings won't be cleared, so you won’t need to set them again.
** Locked files will also be deleted.

Press and hold the FOLDER/
MENU button for 1 second or

longer.
The menu opens. (= P.41)

Press the FF/+ or REW/- button =S
until “FORMAT” flashes on the
display. REL MODE
VLVH
3 Press the REC/SET button.

The formatting process is selected.

Press the FF/+ or REW/- button ==
to choose “START”. FORMAT

(LVINHO4) Jepaooay ay) Bumew.od

Press the REC/SET button again. &
Formatting begins and an indicator
flashes on the display. FORMAT!

“FORMAT DONE?” displays when
formatting ends.

Note
40 If no action is taken within 8 seconds after step 4, the menu will revert to the status of step 2.



Menu List

Press and hold the FOLDER/MENU
button for 1 second or longer.

Press the FOLDER/MENU button

during playback.

Record mode setting (s=P.18). Selection
*® REC MODE between SP and LP modes.
@ @CI VCVAsetting (=P.16). Switch between ON
(enabled) and OFF (disabled).
@ Locking files setting (sP.26). Selection
Lock between ON (locked) and OFF (unlocked).
¢ Alarm playback setting (=P.28).
@ ALARM Selection between ON (enabled) and
¢ Continuous playback setting (sP.22).
@ ALL PLAY Selection between ON (enabled) and

OFF (disabled).
OFF (disabled).

@ CONTRAST LCD contrast adjustment (=P.30).

Adjust the level from 1 to 10.

Backlight setting (=rP.31). Selection
(| BACKLIGHT |between ON (enabled) and OFF
(disabled).

System sounds setting (=P.38).

BEEP Selection between ON (enabled) and

OFF (disabled).
USB Microphone/Speaker setting
(9| USB AUDIO |(:=P.69). Selection between ON
(enabled) and OFF (disabled).
Date/time setting. In order of hour,
ng&DATE minute, year, month and day. (=P.10)
@ FolderName | Folder naming. (=P.32)
@ COMMENT | Assigning file comments. (sP.35)

9> (13| FORMAT Recorder formatting.(=P.40)

Press the FF/+ button or
REW/- button.

,)@ Inserting recording. (= P.15)

-)@ FILE MOVE ? | Moving files. (= P.36)

I Press the FOLDER/MENU button.

Notes

* If you press the STOP button, the REC/SET button,
or the FOLDER/MENU button during a menu setup
operation, the recorder will stop and apply the items
that were set to that point.

* The recorder will stop if you leave it idle for 3
minutes during a menu setup operation, when a
selected item is not applied.

41
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Using DSS Player Software

By connecting the recorder to your PC, you will be able to use DSS Player in the following ways:

* Play and archive voice files from your PC.

* Send voice mail by sending an attached voice file with e-mail.*

* Make backup files of the voice files on the recorder to your PC, and can later transfer files on
your PC to the recorder, as necessary.

* The e-mail software is not included in this package.

Operating Environment
 Windows J

PC: IBM PC/AT compatible PC

Operating System: Microsoft Windows 98/ 98SE/ Me/ 2000 Professional/
NT Workstation 4.0 with SP4 or later/ XP Professional,Home Edition

CPU: Intel Pentium Il class 333 MHz processor or better

RAM: 64 MB or more

Hard drive space: 10 MB or more

Drive: 2x or faster CD-ROM drive

Sound card: Creative Labs Sound Blaster 16 or 100% compatible sound card
Browser: Microsoft Internet Explorer 4.01 or later

Display: 800 x 600 pixels or more, 256 colors or more

USB port: One free port

Audio I/O terminals: Earphone output or speakers

Notes

* USB ports are not available on PCs running Windows 95 or that have been upgraded from Windows 95 to any
other OS.

¢ Certain functions, such as remote and direct recording, do not work on PCs that don't have USB ports.

* Do not use the recorder as a USB microphone/speaker on Windows 98 as computer operation may become
unstable. (Use only with Windows 98SE or later versions of the OS.)



PC: iMac/ iBook/ Power Mac G3,G4/ PowerBook G3
(The computer must support a standard USB port.)

Operating System: Mac OS 8.6/9.0/9.1/9.2/10.1

RAM: 16 MB or more

Hard drive space: 5 MB or more

Drive: 2x or faster CD-ROM drive

Display: 800 x 600 pixels or more, 256 colors or more
USB port: One free port

Audio I/0 terminals: Microphone input and earphone (or speaker) output

I aiemyos Jakeld ssa buisn
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Installing Software

Before you connect the USB cable to the recorder and your PC, you must first install the

software.

Be sure to confirm the following before installation:

 Exit all running applications.
* Eject the floppy disk if you are using one.

* |f you are running Windows 2000 /XP (Professional only) on a network, you need to log on as an

administrator.

Insert Olympus DSS Player into the
CD-ROM drive.

The installation program will start
automatically. Once the program starts,
jump to step 4. If it does not, follow the
procedures in steps 2 and 3.

Click on the [Start] button and
select [Run].

Enter “D:/Setup.exe” in the [Open]
field and click on [OK].
This is assuming the CD-ROM is in drive
D.

aisemyos Buijjeisu|

The installation Language Selection
dialog box opens.
Click on the desired language to select it.

Click on [Next] when the DSS Player
opening screen appears.

44

b

Confirm your acceptance of the
terms of the Licensing Agreement.
You must accept the terms of the Licensing
Agreement to install DSS Player. If you
accept them, click on [Yes].

Register user information.
Register user information. Enter your
name, company name, and license ID
number (serial number).

Thelicense ID number is printed on the license
ID card. Click on [Next]. A confirmation dialog
box opens, click on [Yes].

Select where to install DSS Player.
This lets you specify the folder in which to
install DSS Player. Click on [Browse] to find
the desired installation folder. To accept the
default folder, click on [Next].

Note

If the installation folder does not exist, a
confirmation dialog box opens to get your
permission to create a folder for this purpose.
Click on [Yes].



10

Select a program menu folder.
You may change the program menu
folder to another one, such as [Start Up].
To accept the default folder, click on
[Next].

Authorizing the start of file
copying.

Confirm all “Current Settings”. To accept
them, click on [Next].

Note

To change the program menu folder or
installation folder, click on [Back].

Copy files.
Wait until DSS Player is installed on your
PC, then click on [Finish].

Set up Acrobat Reader.
When the Acrobat Reader Setup dialog
box opens, click on [Next].

Select where to install Acrobat
Reader.

Specify the folder in which to install
Acrobat Reader. To accept the default
folder, click on [Next].

Setup Status.
Wait until Acrobat Reader is installed on
your PC.

Exit Acrobat Reader setup.
When the Exit Setup dialog box opens,
click on [OK].

16

Install Shield Wizard complete.

You may be requested to restart your PC
when setup is complete. If so, make sure
that [Yes, | want to restart my PC now.]
is selected before clicking on [Finish].
Then, when the message to do so
appears, shut your PC off and restart it.

aiemyos Buijjeisu|
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Insert DSS Player for Mac into the
CD-ROM drive.

Double-click on CD icon.
Double-click on the desired language to
select it.

Double-click on DSS Player for Mac
Installer icon.
The installation program will start.

Click on [Continue] when the DSS
Player for Mac opening screen
appears.

Confirm your acceptance of the
terms of the Licensing Agreement.
You must accept the terms of the Licensing
Agreement to install DSS Player for Mac.
If you accept them, click on [Agree].

Select where to install DSS Player
for Mac.

This lets you specify the folder in which to
install DSS Player for Mac. To accept

the default folder, click on [Choose].

If you use OS10.1, proceed to step 7.

Install software inta folder:

From: [ OLYMPUS

| [ Applications » [ oLYmpus e
|7 Developer P | & Preview

| (@ Library » e Player

| (2 system > &
B Users » Stick

{ NewFolder ) { Add to Favorites

Go to:

{ Cancel ) ( Choose ’
e

Restart the computer.
You need to restart your computer when
DSS Player for Mac is installed. To
continue, click on [Yes]. To cancel
installation, click on [No].

Completing setup.

Installation has finished.

Click either [Quit] or [Restart]. To continue
with the installation, click the Continue Set
up Acrobat Reader.

When the Acrobat Reader Setup dialog box
opens, click on [Next].



Uninstall Software

The process of removing software installed on your PC is called uninstalling. Perform uninstalling

when you no longer need the software.

[ Windows ]
1 Exit DSS Player.

Click on the [Start] button,
select [Programs], then
[Olympus DSS Player 2002].
(in Windows XP, click on the [Start]
button, select [All Programs], then
[Olympus DSS Player 2002].)

2

N (3 Accessaies

(B Games

4 Orline Services

, [ statlp

‘

& Intermet Explorer
» (53 Outlook Express
P Windows
fl & Obmpus DSS Player 2002
@ BN Viavoice Vioicelenter &2 Help

m Acrobat Reader 5.0 E D5-330 ONLINE INSTRUCTIONS

og Off B2033,

& B Qs LY

Windows [Yle Milennium Edition

DSS Player 2002].

Shut Down.

3 Click on [Uninstall Olympus

N> =)

Follow the directions on
screen to start the uninstall
process.

[ %]

aiemyos |eisuiun
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{ Macintosh/
Exit DSS Player.

icon.
If you use 0S10.1, proceed to step 5.

Delete the following eight drivers
from Function Enhancement in the
System Folder:

(OS 8,9 only)

“DSS10USBDriver”

“DSS10USBShim”

“DSS1USBDriver”

“DSS1USBShim”

“DSSFSUSBDriver”

“DSSFSUSBShim”

“DSSUSBDriver”

“DSSUSBShim”

Delete the following folder
4 from the System Folder:
(OS 8,9 only)
“DSS Player for Mac Help”

2 Double-click the Macintosh HD

Delete the following file from
5 Initialization in the System Folder:

“DSS Preference”

(In OS10.1, User folder: Library folder:

Preference folder.)

6 Delete the DSS Player for Mac folder.

If you optionally created a new message folder,
be sure to delete that message folder as well.



Using Online Help

To open Online Help, do either of the following:
(Windows)

* Click on the [Start] button, select [Programs], then [Olympus DSS Player 2002], then click on

[Help].

* While DSS Player is running, choose [Contents] from the [Help] menu.
¢ While DSS Player is running, press [F1] on the keyboard.

(Macintosh)

¢ While DSS Player is running, choose [DSS Player for Mac Help] from the [Help] menu.

[ Search by contents |
Once the Online Help screen

appears, click on the Contents
tab.

Double-click on the @ icon of
the desired topic heading.
The title of the topic is displayed.

Double-click on the[2]icon of the
desired topic.
An explanation of the topic is displayed.

Help Topics: Olpmpus DSS Player 2002 Help
1 # Contents | Index | Find |

Click a book, and then click Open. Or click anather |

2 ‘ P wielcome to "Olympus DSS Player 2002

Let's Get Started

@ gt ted:
3 A DSS Plaper 2002 Guided Tour

Q Commands
Q Other Features

Note

For more information on menus and operations, refer to Online Help. You will be able to use Online Help after

DSS Player is installed.

[ Search by keyword |

Once the Online Help screen
appears, click on the Index tab.
A list of keywords by which you can
search is displayed.

Enter text.
Matching keywords are located
automatically.

Choose a topic, then click on

[Display].
An explanation of the topic is displayed.

Help Topics: Olpmpus DSS Player 2002 Help

1 — |Find |

1 Tupe the first few letters of the word you're looking

2 ‘ [Cerd

2 Click the index entry pou want, and then click Dist

djaH aunuQ buisn
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Connecting to Your PC

Be sure to finish installing DSS Player before connecting the recorder. If you connect the recorder
before installing DSS Player, the “Add New Hardware Wizard” dialog box will open. If this happens,
click on [Cancel] to exit the wizard, then install DSS Player.

Once you connect the recorder to your PC, the included USB cable will supply the power so you
will not have to use batteries or an AC adapter with the recorder.

You can directly connect the recorder's USB terminal to your PC, or use the cradle included in the
package (desktop holder).

Connecting to your PC using the USB
connection cable

Insert end A of the USB cable to your
PC's USB port or USB hub.

Confirm that the recorder is not in
2 use before attaching end b of the

USB cable to the PC terminal port

of the recorder.

“REMOTE” is displayed on recorder if the

USB cable is connected.

Notes

* NEVER disconnect the USB connecting cable while the record/play indicator lamp is flashing. If you do, the
data will be destroyed.

* Some PCs and USB hubs may not supply sufficient power and the recorder may not connect. If that happens,
turn the USB AUDIO "OFF" in the recorder's menu settings. (== P.41)

 Refer to the user's manual for your PC regarding the USB port or USB hub on your PC.

* Be sure that you connect the USB cable either directly to the USB port on your PC or the self-power (AC
adapter connection) USB hub.

* Be sure to push the cable connector all the way in. Otherwise, the recorder may not operate properly.

* Release the HOLD switch. (== P.9)



Connecting to your PC using the cradle

[ Place the recorder on the cradle |

1 Insert end A of the USB cable to your PC's USB

port or USB hub.

Connect the end b of the USB connection cable

to the cradle.
M Make sure that the recorder is stopped, and place
it in the cradle.

When you place the recorder on the cradle, Minsert the
recorder so its bottom slot meets the hook on the front of
the cradle (at the low end). @Hold the top of the recorder
and push it against the cradle until it clicks.

“REMOTE” is displayed on recorder if the USB cable is
connected.

| Remove the recorder from the cradle |

Make sure that the recorder's record/play indicator
lamp isn't flashing, and remove the recorder from
the cradle.

Hold the cradle with your hand, and raise the recorder from
the top end to remove it from the hook, as shown in the
illustration.

5 Disconnect the USB connecting cable.

Notes

* Do not needlessly touch the connection point on the front of the cradle (at the low end), as that may cause
damage resulting in a bad connection.

* Release the HOLD switch. (= P.9)

2d Inoj o} Bunoauuo)
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Running DSS Player

[ Windows ]
1 Start Windows.

Connect the recorder to your PC.
For the connection procedure, refer to e —
“Connecting to Your PC”. (== P.50) s Ganes

When you connect the recorder to your g , ;‘ui‘

PC for the first time, the USB Driver Setup @ » 55 Cutock Ees

Wizard will open. Follow the instructions =14 2

on the screen to inSta” the driver. E] f:ju:‘:\:::u:uimy T 05-330 ONLINE INSTrANS
<] Log 01 2053 T Uninstall Ompus DSS F Il 2002

Click on the [Start] button, select S

[Programs], then [Olympus DSS s o B

Player 2002].

(in Windows XP, click on the [Start] button,
select [All Programs], then [Olympus DSS
Player 2002].)

<o mp

Click on [Olympus DSS Player
2002].

I 19he|d ssa Buiuuny

[ About automatic startup |

By connecting the recorder to your PC, you can automatically start an application.

© Right-click on % icon of the Task Bar on the lower right-hand corner on the screen,
then click on Select startup application.

@ Check the application to automatically start.
The application that you check will automatically start. If you do not want it to automatically
start, uncheck the application.

Notes

* You will not be able to run the included DSS Player 2002 and DSS Player 3.0/3.1/3.5 for DS-150/320 at the
same time.
« If you connect the recorder before installing DSS Player, the “Add New Hardware Wizard” dialog box will open.
52 If this happens, click on [Cancel] to exit the wizard, then install DSS Player.



To start DSS Player for Mac, follow these steps:
It is assumed that DSS Player for Mac has been installed. For installation instructions,
see Installing DSS Player for Mac. (== P.46)

Start your Macintosh. ‘800 o =)
@Fc B ¢ @ A
Back View Computer Home Favorites Applications
Connect the recorder to your 3 DSS Player for Mac DSS Installation Log
PC.
For cable connection instructions, see
“Connecting to Your PC”. (== P.50)
808 [ DSS Player for Mac o
3 Double-click the DSS Player cEEm B f ¢ A
for Mac folder. 4 > ’ "
The DSS Player for Mac folder opens. us?}n;ver

Double-click DSS Player.
DSS Player for Mac launches.

I 19he|d ssq Buluuny
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Window Names

# DSS Player 2002 - DS-330(D533)\FOLDER A\DS330001.dss.
Fie Edt View Took

Dawnlead Voice Recogniion Help

=loix]

28 ¢ X[EBROREI B0 m[w-t %

Position Length.
O [eeelimiw e ] »> mmimrg N3
‘J : : : | o0 bl

[IB Dictsion Fader
=@ Dornload Tray
Folder A 0
(£]DSIB003dss 3/14/2002 1144 P 1:1236
Folder & E]DSI0004 dss 31472002 11:45PM 00012
FolderD & -
(DS330005dss 3/16/2002 11:45PM 00017
1 Dictation Tray
& Message Tray

i

Folder B
% FokderE

Device Manager

©-@ DS330D533)

Standard DSS Fie
Long DS5 Fie
Long D85 Fie

(Macintosh)

D5-330:FOLDER A:DS330001

% FOLDER A

FOLDER B

Length
aHO1 M1

FOLDERE

FOLDERC
Tatalof 5 messages

(Windows)

WOL |SPEED

T olctaton Faer

[ Goes | tme | Lewgtn  [eoomy | Vot |2

] oovmioadTrey
Q Folders
Q Folders
Q Foldere
Q Foldero
Q Foldere

B oovcs Movoger
B os-330
W roweRs
& rowens
& rowoens
& rouoeno
q rowene

- psz30002
| 05330003
|| psz30004
| ] os33000s

4

3/1arz
31402
a0z
a14002
360z

105120 PN
10:51:43 PM
11:4436 PM
114517 PM
11:45:20 PM

[EIE 7
00HOOM1 85
LIEIEREES
00HOGMI 25
00HoOM1 75

Total of 5

@ Play Control Bar
Control buttons to play and stop voice files.
(2 Dictation Folder Window
Will display the directory structure of the
DSS, WMA, WAVE (Windows only) and
AIFF (Macintosh only)-format files
stored on your PC's hard disk.

(3@ Device Manager Window
Will display the directory structure of the
folders in the recorder.

@ Voice File List Box
Will display the folders selected in @ and
©)



Import Voice Files to Your PC

Importing voice files to your PC from the recorder is called downloading. With DSS Player, there
are three ways to download voice files to your PC:

* Download Selected Files
Download one or several voice files to your PC.
* Download Folders
Download all the voice files in one folder.
* Download All
Click on the @; icon and download all the voice files stored in the recorder to your PC.

The following is an explanation of “Download Selected Files”. For explanations of “Download Folders”
and “Download All”, refer to Online Help.

Download Selected Files

’ & Message Tray

Select the folder. oo
From the Device Manager window, select the folder that 1 q”[a e
contains the voice file you would like to download. The gggggggﬁ
illustration shows that Folder A has been selected. EE FoLoER D

[Total of 5 messages

Select the voice file. UL [ S ) | T

@

24

Selectthe voice file you would ke todownload =~~~ oo |
. . . 0.30 .00
from the Voice File List Box. To select more 4 [FieName - Created Dals Fecording Length | Comment
H H H p 1 dss  3/14/200 0:31 Pt 0:01:15
than one file, hOld e|th§r the [_Ctrl] or [Shift] D533002.dss 3!14/221:31 PH u:we
key and select files. The illustration shows that 6| DS30003dss - 3/14/2002 1144 P 11236
. . . [|§DS33[I[IEI4 dss 341472002 11:45 P 0:00:12
one voice file is selected. 2 DS30005.dss 3162002 11:45PM  0:00:17

9d Ao, 0} s3ji4 99107 Hodw
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Import Voice Files to Your PC

Download the voice file. b002 - D5-330(D533\FOLDER A\DS330001.dss
. Tools | Download Yoice Recogniion  Hel
(WIndOWS) ‘ 3 Download Falder & b ‘ =) | v @ ‘ o] -
From the [Download] menu, click on —— Doae F
[Download Selected Files]. = Dormiss a3 ) i T % A
Macintosh L EEr———— | o
( ) . - Download Al Crl+Shift+M 2 =
From the [Tools] menu, click on Fecording Lengh | Camment
. Tray Upload Fles... 31PM 00115
[Download Selected Files]. A 31 FM Con s
B Edit & Upload Templates... CiibsT
c T D 44 PM 11238
I Transter UssID! [45FM 00012
Download complete. x

Once the transmission screen closes and the

record/play indicator lamp on the recorder E% g )

goes dark, the downloading is completed. to Folder &

DS330001.dss

Cancel I

I 9d INOA 0} S3ji4 9910\ Hodwi|

Notes

* NEVER disconnect the USB connecting cable while the record/play indicator lamp is flashing. If you do, the
data will be destroyed.

* Depending on the size of the voice file and your PC, it may take some time to download the files.

* The downloaded files will be stored in the download tray folder that corresponds to the folder in the recorder.
(Example: A voice file downloaded from Folder A will be stored in download tray A on your PC.)

« If a voice file already exists on your PC with the same name, date and time recorded, the new file will not be
downloaded.

56



Play a Voice File

Select the folder.
Select the folder that contains the voice file 3

you would like to play.

The illustration shows that to select from |4 & ¢ g |>llm|ﬁs =N
among voice files already downloaded, Folder SO m e e | v | g e
Ain the Dictation Folder window was selected. | T

lo.00 loz0 ' ! ! ! [1.00 " 1
Dictation Folder ' ile Mame Created Date. Recording Lengt

Select the voice file. EX - DMF”U'E;‘BV i 34 TEM 00115

. ) . . ] DST002e H14/2002 g PM 00018

Select the voice file to play from the Voice File %Fﬂ'dﬂﬁ | oot réiznn: AN 112

. ~4g FolderC (2 DSe0004.dse 34200211 [l P 00012

List Box. % ::3:2 8 D3 000505 3162002 11 [l P 00017
-1 Diotation Tray

Loy Message Tray

Play the voice file.
Click on the [l (play) button of the Play  [£§ 5:xmes 1 2
Control Bar. L FOLDER A

Other play controls such as Rewind, Fast Forward, Stop, Speed Control, Volume Control, Time
Axis, and Index Skip can also be operated. For details, refer to Online Help.

If you connect the recorder and use DSS Player to play back a file, you can use the recorder as
your PC speaker. For connection procedures, see "USB Microphone/USB Speaker". (== P.69)

File name
File names are assigned in the following manner:

DS330001.dss
L LExtension

File number ....... A serial number automatically assigned by a Digital Voice Recorder.

UserID ....... The name that has been set on the Digital Voice Recorder. The default name on the
Digital Voice Recorder is DS33. The user ID can be modified with DSS Player. ( = P.62)

Note
DSS Player cannot play back WMA files with DRM (Digital Rights Management) copyright protection that constrains
distribution and playback.

a|14 9010 € Aeld
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Upload Voice Files to the Recorder

DSS Player has a feature to enable you to upload DSS-format voice files from your PC to the
recorder.

Select the folder. B 5 B S B
Select the folder that contains the voice file o e Lt o L beandtae s Lo

E By Dowrload Tray 3/14/200210:31 PM_0001:15

d:

; ; . ") Folder & o
: (4] D5330002dss 3/14/200210:31 PM 0:00:18
to upload from the Dictation Folder window. 5 %rmders i i Ao e
i ottt (£ D5330004.ss 34v2002 11 [l PM 00012
Select the voice file : % ol (#]D5330005 des 341672002 11l PM 0100117
|:| Dictation Trap

Select the voice file to upload from the Voice

File List Box. e T
-} Ds-3300533)

Select the folder to upload. A FoLER A 1 2

(Windows)

From the [Download] menu select [Upload Files] or click on the Upload icon. Once the folder

list box where the file is to be uploaded is displayed, select the folder from which the file is to

be uploaded.

(Macintosh)

From the [Tools] menu, click on [Upload Files].

Upload the voice file.
The voice file is uploaded to the recorder.

o Message Tray

Upload complete.
Once the transmission screen closes and the record/play indicator lamp on the recorder
goes dark, the uploading is completed.

You can also drag and drop files from the Voice File List Box to the Device Manager window.

Notes

* NEVER disconnect the USB connecting cable while the record/play indicator lamp is flashing. If you do, the
data will be destroyed.

* You will not be able to upload a file if another file with the same name already exists at the destination.

* You can upload only DSS files to the recorder.



Direct Recording on PC and Editing on PC

If you want to record and edit voice files using your PC, open the [Remote Edit] window while the
recorder is connected to your PC (s= P.50). You can easily create new files, insert recordings, overwrite
recordings, edit index marks, and do other tasks. See the Online Help for details.

4 1emote edit - Folder AADS330001_1.dss

File Edit Took Help

=10l ]

DH|v@@xz|U

Quality

Sersiivity

Pasition Length [~ oy
I Insert recording
® | e | =m | » [ »r ]| |
W I -

Wl

|n oo ‘n a0

I = Valume

‘mnl

|Stop |psa3

|Recording a new file|

1

2
J

From the Main Window, select [New
File] in the [File] menu, or click &
icon.

Remote Edit screen opens.

Press the | ® | (record) button to
start recording.

Press the .. =
stop recording.

(stop) button to

| Editing existing files|

1

2d uo Buip3 pue 9d uo buipiooey 18i1q

From the Main Window, select the
file you want to edit from the Voice
File List Box.

Select [Edit File] in the [File] menu,
or click # icon.
Remote Edit screen opens.

Edit it.

You can partially delete recordings, edit
index marks and priorities, insert recordings
from the position designated using the
position control bar (check on [Insert
recording]) and overwrite recordings.

Notes
* You cannot edit WAV files.
* You can only edit files in DSS format.
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Direct Recording on PC and Editing on PC

You can record voice files from a Digital Voice Recorder directly to a computer. With a Digital Voice
Recorder connected, choose the [Direct Record to PC] command from the [Tools] menu.

|Recording a new file|

e

Set I'ecording. Set Recording Specifications

A recording setup window opens. et
Click on [Set File Name].

"set File Name...

— GQuality
=) High Quality
® standard

O Long

Semsitvity

® Dictation

O Conference

Max Recording Time:
Sampling (Hz)
Bit Rate

12kHz
13.7kbps

I 9d uo Buip3 pue Hd uo Buipioaay 10a41q

£ Cancel Start

S —

save

Set the recording destination and

file name. Save As: [data- 1

Where: [ [ FolderA

Type the recording destination folder —

name and file name and click on [Save]. (7 Messagerolder

C ol
P [ Fol
[ Fol
[ ol
[ Fol

IderA >
Iders »
IderC »
IderD L
I derE. »

===
" New Folder Add to Favorites

60

(" cancel

S ———

2



_ . . . — File name
Click on [Staﬂ] in the recordlng setup window. Mac 03 K: Applications: OLYMPUS: DSS Player for Mac:

MezsageFolder: Folders: data- 1 dss

3 Start I‘eCOI’ding. Set Recording Specifications

Recording will start.
You can only change the sound quality and

sensitivity settings before recording. (SetFile Name )

— Quality Sensitivity o
= 3
™) High Quality ® Dictarion 8
® Standard
© conference %
© Long 3
o
— Information a8
Ve Recarding Time: 1509HO7H1 65 5
Sampling {He} 12kHz Q@
Bit Rate: 13.7kbps g
oy 3
(CCaneel ) TS0

Cancel Start o
3
o
g
Stop recording. Recording =
. . . Recording E]
Click on [Stop] in the Record Window. Q
Bit Rate: 13.7kbps °
Hard Drive Space:  1813649KE E]
HacTime: 00:00: 07 g

et

|Converting File Formats to AIFF Files* f

Choose the [Save as] from the [File] menu. 4
When a DSS file is converted to an AIFF file, unique DSS
information such as priority and index marking will be lost.

* AIFF format ......... The standard Macintosh audio file format with the aif extension. It cannot
contain index and priority settings.

Notes
 AIFF files cannot be converted to DSS format.
* You cannot partially delete, add index marks to, or set priorities.
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Send Voice Files with E-mail

You can attach voice files to your e-mails.

How to send attachment with e-mails, refer to the user's manual for your e-mail software.

* Even if the person to whom you send a voice file does not have DSS Player, he/she will be able
to play the voice file using DSS Player-Lite. You can download DSS Player-Lite free from the
Olympus home page, http://www.olympus.com/

1 Start DSS Player.
2 Start the e-mail software, then select New Mail.

Attach the voice file.
Select the voice file to attach from the Voice File List Box of DSS Player and drag and drop
the file into the New Mail text window.

Note

If your e-mail software is not compatible with the above operation, select the voice file to send from the folder
where the voice file is located and send the file as an attached file according to the functions of the e-mail software.
(Windows) The default folder is set to C:\Program Files\Olympus\DSS Player 2002\Message\Folder A (or B, C, D, E).
(Macintosh) By default,voice files are stored on Macintosh HD: DSS Player for Mac: Message Folder: FolderA (or B, C, D, E).

Changing User ID

The user ID is used in DSS file names (= P.57) that are recorded on a Digital Voice Recorder.

Enter the user ID in the [Transfer UserlD] window. x|
(Windows) From the [Download] menu. o 2
(Macintosh) From the [Tools] menu. [pszd Tll «
Click on [Transfer]. —t

The new user ID will be transferred to the Digital

Voice Recorder. 1



Changing a Folder Name

Changing a folder name in the Voice Folder window

(Windows)

You can change a folder name using the [Rename Folder] command from the [Edit] menu. A
folder name can be up to 20 characters long and cannot use \ /:*?"<>|.

(Macintosh)

Choose the [Rename Folder] command from the [File] menu.

Changing a folder name in the Device window

(Windows)

Right-click the folder name to change, select the [Rename Folder] and input the new folder
name.

(Macintosh)

Choose the [Rename Folder] from the [Tools] menu and type a folder name.

The names of the folders on the Digital Voice Recorder is updated with the new folder names.
Device Window folder names consist of a string of eight or fewer single-byte alphanumeric characters.

Editing File Comments

You can use a PC to create or edit file comments in DSS Player in the [Edit Comments] window,
and transfer them from the PC to the recorder. You can also edit file comments imported from the
recorder to a PC.

Choose the [Edit Comments] command from the [Tools] menu.
Files comments can use up to 100 alphanumerical characters and symbols.

sjuawwo) 34 bunip3 / awep Japjo4 e Buibueyn
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Editing a Template

You can edit folder name and file comment templates in DSS Player in the [Edit & Upload Templates]
window and transfer them to the recorder. Templates downloaded from the recorder can also be

edited.
(Windows)
Select [Edit & Upload Templates] from [Download] to open the [Edit and Upload Template]
window.

(Macintosh)
Select [Edit & Upload Templates] from [Tools] to open the [Edit and Upload Template] window.

Up to 20 alphanumerical characters can be used for a folder name or a comment.

x
peemment | _— Transfer edited content
Nodt | Hob | Upload turecudell'/ to the recorder
Moz [ No? | swe |
Nod | Nog | .
Save edited content
Mot | Nog | &l‘
Nos | Ho 0 | Clear L
Read saved content
r—Folder nam¢
Mot | Nob | Upload to recader
" Delete edited content
o2 | No? |
save |
Mo | Hog |
Met | Nog | |
Nos | No10 | Clear
Loar from recode | Uploard 41| Cleartl | Concel |
Upload templates  Transfer all Delete all changed Close the
from the recorder  comment and content dialog box

folder information
to the recorder



Using Voice Recognition Software (optional)

When you use voice-recognition software such as IBM ViaVoice, it is recommended that you set
the recorder to PC microphone and have the software learn the characteristics of the speaker’s
voice and the recorder’s built-in microphone to maximize the accuracy of voice recognition.

1 Click the [Start] button and select [Programs] — [IBM ViaVoice VoiceCenter].

Click the [ViaVoice] button of [IBM ViaVoice VoiceCenter], then select [Tool]
and [Analyze My Voice].

The [ViaVoice User Wizard] [ Viavcice LR E
3 window appears.
Select [Olympus DSS File] in the
[Device] list box, then click the [Next]
button.

| to the User Wizard

| Pleass type a desciiption for your voice madel. or select one
| iom the Woice Model st

| User Name: OLYMPUS

|

| Device Olprnpus D55 File [~
T T

Vice Modet

| Language: S English

Vi

The [Audio Setup Wizard]
window opens.

Use PC connection cable (KP4) if you .
use Windows 98, or use the USB
connection cable if you use Windows & o
98SE or later operating system
versions.

< Back. I Hext > I Cancel

(teuondo) asemyos uoubooay aolop Buisn



(reuondo) asemyos uonuboaay asiop Buisn

66

|Using the USB Cable | =

Selecting a Sound Card

The wizard detected muliple sound cards in your system.
Select the cards to use for ViaVoice.

@ Connect the recorder with the USB cable, and
follow the instructions on screen.
Release the HOLD switch.
(@ [Selecting a Sound Card]
When the [Selecting a Sound Card] window
appears, select [USB Audio Device] for [Input] and
follow the instructions on screen. (Select
[Microphone Control (DS-330)] for Windows XP.)
During audio setup or while enrolling, please
input voice data from the recorder.

Sound Cards

Duput

USB Audio Device: -]

A Cick Nextto continue.

<Back Cancel

| Using the PC Connection Cable|

@ Do not connect the recorder, and follow the instructions on screen.

(@ [Connect Input Device]
When the [Connect Input Device] window appears, connect the recorder and your
PC using the PC connection cable by following the instructions on screen. O
To input voice during audio setup or while enrolling, turn on the microphone CTRATH PO |
by pressing the NEW button on the recorder. "TRAIN PC" appears on the ]
recorder display.

We recommend you enroll the surrounding environment using the recorder before using voice
recognition on files. This enables you to better register the characteristics of your voice to improve
recognition.

Notes

» Set the recording mode to "SP" when enrolling using the PC connection cable (KP4). If you set it to "LP" mode,
a warning "CHANGE REC MODE" appears and you won't be able to enroll. (== P.18)

* Turn "OFF" the USB AUDIO on the recorder's menu settings and use the PC connection cable (KP4) to enroll.
(= P41)

* Voice recognition is only available with Windows operating systems.



Executing Voice Recognition

Select the folder. B |3 x|2bhoFIB 0|y s|d-

Select the folder containing the voice « | = T iﬂ

file you want to process with voice J - %ﬁ) T

rgcognltlon from the Dictation Folder T ; el

window. FR e N
L[ Folder B

Select the voice file. % Folde

Select the desired voice file to process Iy Nl

with voice recognition from the Voice ch Hessoe Trey

File List Box. [T E—— 3

Start of voice recognition. =
Click the start voice recognition icon .
The voice recognition software window appears and voice recognition starts.

|Noise Canceling Function |

Check [Use Noise Cancel] in [Voice Recognition] on the  ymermen Trap\Folder A\DS 330001 dss
menu bar, to output voice using the noise canceling paynload [ Voice Recoaniion  Help
function to the voice recognition software. x | = Start Woice Recogrition

Woice Recognition Range #

Cancel

. . . » v Use Mo e
See the voice recognition software operating manual for 4 Automatic Plapback
voice recognition functions such as modifying converted Show Progress
characters.

(reuondo) atemyos uoniuboaay asiop Buisn
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— Notes on Recording For Voice Recognition

When recording voices for use in voice
recognition, set up your DSS recorder
as follows to facilitate recognition.

» Set the microphone sensitivity to "DICT".
(= P.19)

* Set the recording mode to "SP". (== P.18)

» Set the Variable Control Voice Actuator
(VCVA) to "OFF". (= P.16)

* Only record voices that have already been
registered in the voice recognition software
speak.

* Record in a relatively quiet environment.

* Have the person speaking within 5-10 cm
of the built-in microphone of the recorder
(5to 10 cm).

* Speak continuously.

Voice files recorded under the following
conditions cannot be processed by
voice recognition because their
recognition rates may be very low.

* A conference or meeting where the voices
of many people have been recorded.

* Seminar or lecture in which ambient noise
tends to be recorded.




USB Microphone/USB Speaker (USB AUDIO)

Using the recorder as a USB speaker

This recorder can be used as USB speaker when it's  prreasrmmersn Trap\Folder A\D5330001_1.dss
connected to a PC. If you use the recorderas a USB [ ook Dorload Vice Regagrition Help

speaker, you can output voice from the recorder Detect Devics ¥ B | = | v

Edit Comments

without using a PC speaker. Posiion _ _Length

PC Speak:

Select [Select Speaker] from [Tools] on the menu Flay Al Chi+F12
bar, and choose voice output. Stan AbTlF11

Using the recorder as USB microphone

This recorder can function as a USB microphone when it's connected to a PC. If you use voice
recognition software or other applications, you can use the recorder as a USB microphone.

| For Windows 98SE, Me, 2000 |

Select [Control Panel] — [(Sound and) Multimedia] — [Audio] tab, and choose [USB Audio Device]
from among the recording devices.

| For Windows XP |

Select [Control panel] — [Sound, Voice, and Audio Device] — [Sound and Audio Device] —
[Audio] tab, and chose [Microphone Control (DS-330)] from among the recording devices.

Notes

* USB speaker can be switched using [Control Panel], in the same manner as the USB microphone.

* Do not use the recorder as a USB microphone/speaker on Windows 98 as computer operation may become
unstable. (Use only with Windows 98SE or later versions of the OS.)

* The recorder can be used as a USB microphone/speaker only with Windows.

« If you turn the USB AUDIO "OFF" using the recorder's menu setting, you cannot use the recorder as a USB
Microphone/USB Speaker. (== P.41)

* You cannot use the recorder as a USB Microphone/USB Speaker on Windows NT.

(o1anv asn) saxeads gsn/auoydosdiy gsn
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Alarm Message List

Message Meaning Explanation Action
BATTERY LOW Low battery Battery power is getting low. Replace with new batteries.
power (= P.8)
LOCK ON Erase-locked Tried to delete a locked file. Unlock the file. (= P.26)
INDEX FULL Index full The file is full of index marks Erase index marks that are no
(maximum of 16 marks). longer required. (= P.27)
FOLDER FULL Folder full The folder is full of files (maximum Erase unnecessary files. (= P.24)

of 199 files).

Maximum number

The destination folder already has
the maximum number of files
(199).

Erase unnecessary files. (== P.24)

MEMORY FULL Zero remaining No remaining internal memory. Erase unnecessary files. (v P.24)
memory
NO FILE No file No files were found in the folder. Select another folder.
CHANGE REC Change recording For voice recognition applications, the = Set the recording mode to SP when
MODE mode recording mode cannot be set to LP  using connection cable KP4.
when using the connection cable KP4. (= P.18)
MEMORY ERROR  Error in the internal Error in the internal memory. This is a malfunction, so go to the

flash memory

store where you purchased the
recorder or an Olympus service
station for repair.

SYSTEM ERROR

System error

System error detected in the
recorder.

This is a malfunction, so go to the
store where you purchased the
recorder or an Olympus service
station for repair.

OVER FLOW Too many Exceeds the maximum number of  Reduce the number of characters
characters input  characters that can be registered.  within the limit. Up to eight
characters can be used for a folder
name. (= P.32-34)
Up to 100 characters can be used
for a file comment. (= P.35)
TRAIN PC PC microphone The recorder is being used as a See DSS Player online help for
indicator PC microphone. (== P.66) details.
FORMAT ERROR  Formatting error  There was an error while Reformat the memory. (== P.40)

formatting the recorder's memory.




Troubleshooting

Symptom Probable cause Action
Nothing The batteries are not loaded properly. Verify polarity is correct.
appears on The batteries are dead. Replace with new batteries.
the display If none of these suggestions works Reset the recorder. (== P.40)
The recorder is in HOLD mode. Release the recorder from HOLD.
(= P.9)
Won't start The recorder is in HOLD mode. Release the recorder from HOLD.
(= P.9)
The batteries are dead. Replace with new batteries.
Unable to Low remaining internal flash memory. Erase unnecessary files.
record The maximum number of files has been reached. Check another folder.
No playback  The earphone is connected. Unplug the earphones to use the
tone heard internal speaker.
The VOLUME control is set to 0. Adjust the VOLUME control.
Unable to The file is locked. Unlock the file. (= P.26)
erase
Noise heard The recorder was shaken during recording. —
during The recorder was placed near a cell phone or Move the recorder.
playback fluorescent lamp while recording or during playback.
Recording The microphone sensitivity is too low. Set the microphone sensitivity to
level too low CONF mode and try again. (== P.19)
Unable to set  The maximum number of index marks (16) has been Erase unnecessary index marks.
index marks reached. (= P.27)
The file is locked. Unlock the file. (= P.26)
Won’t work A non-standard AC adapter is being used. Use the Olympus A321 (for US,
with AC Canada) or A322 (for Europe
adapter except U.K) AC adapter
(Oprional).
Cannot find Wrong folder. Switch to the right folder.

the recorded
voice
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Symptom

Probable cause

Action

Cannot use
Fast Playback
or Slow
Playback

Noise Cancel function is set to "LOW" or "HI".

Turn "OFF" the Noise Cancel
function. (== P.23)

Noise Cancel
function
doesn't work

A file is being played back in Fast Playback or Slow
Playback mode.

The Noise Cancel function doesn't
work while a file is being played
back in Fast Playback or Slow
Playback mode. (= P.21)

Cannot
connect to PC

Some PCs and USB hubs may not provide sufficient
power.

Turn the USB AUDIO "OFF" in the
recorder's menu settings. (== P.41)

Cannot
connect to a
PC using a
cradle

Sometimes a connection cannot be made with some
PCs running Windows XP.

You need to change the PC's USB
settings. See DSS Player online
help for details. (== P.49)




Accessories (optional)

External microphone: ME9*/11*

Alavalier omnidirectional microphone that clips
to clothing. Use to record your own voice or
people near you.

Conference microphone: ME7

A highly sensitive directional microphone
(shotgun microphone). Use to record speakers
at a distance.

Headset: E102

Stereo headset for your PC. A helpful tool for
PC based transcription.

Foot switch: RS23/24

Connect to the serial or USB port of your PC
for hands-free transcription convenience.

Noise-Cancellation microphone: ME12
(Dictation microphone)

Used to get crisp recordings of your own voice
by reducing the effects of ambient noise.
Recommended to improve the accuracy when
using voice-recognition software.

AC adapter: A321 (US and Canada) or A322
(Europe except U.K.)

Connecting cord: KA232*

Use to connect the microphone jack of this unit
to a radio or other sound source.

Plug adapter: PA3

An adapter that connects devices such as
microphones with 2.5 mm mini-plugs to the
unit's 3.5 mm mini-jack.

* Use these accessories with the PA3 plug
adapter.
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Specifications

Recording format ... DSS (Digital Speech Standard)
Inputlevel ... —70 dBv
Sampling frequency

SP mMode: ..ot 12 kHz

LP mode: ..o 8 kHz
Overall frequency response

SP MOE: ..ot 300 to 5,000 Hz

LP mode: 300 to 3,000 Hz
Recording time

SP MOode: ..o 2 hours 35 minutes

LP mode: ..o 5 hours 30 minutes
Battery life

Recording: ....cooeeiiiiiiee e Approx. 12 hours

Playback: ........ccooiiiiieiiiice e Approx. 8 hours

(with alkaline batteries, based on our standard testing
procedure)

SPEAKET ...ttt Built-in 28 mm round dynamic speaker
Microphone jack ...........c.ccoooiiiiiiiiiniciicee 3.5 mm mini-jack, impedance 2 kQ
Earphone jack ... 3.5 mm mini-jack, impedance 8 Q or more
Maximum working output (3 V DC) ................... 250 mW or more (8 Q speaker)
Input power requirement

Rated voltage: ........ccccvvireiiiincii s 3V

Batteries: ........c....... Two AAA batteries (LRO3 or R03)

External power supply: .......ccccoeuireeierinceennn AC adapter
External dimensions ... ... 108 x 41.5 x 21mm (without protrusions)
Weight ..o 75 g (including batteries)

* Specifications and design are subject to change without notice.
* Battery life varies greatly according to type of batteries used and the conditions of use.



Technical Assistance and Support

The following are for only technical questions and support about OLYMPUS recorder and software.

@ Technical Hotline Number in the U.S. and Canada
1-888-553-4448

& User Support E-mail address in the U.S. and Canada
distec@olympus.com

@ Technical Hotline Number in Europe
Toll free number
00800 67 10 83 00
available for Austria, Belgium, Denmark, France, Germany, Netherlands, Norway, Sweden,
Switzerland, United Kingdom

Charged numbers

+49 180 567 1083

available for Finland, Italy, Luxemburg, Portugal, Spain and Czech Republic
+49 40 23773 899

available for Greece, Croatia, Hungary and the rest of Europe

& User Support E-mail address in Europe
dss.support@olympus-europa.com
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OLYMPUS OPTICAL CO,,LTD.

San-Ei Building, 22-2, Nishi Shinjuku 1-chome, Shinjuku-ku, Tokyo, Japan. Tel. 03-3340-2211
OLYMPUS AMERICA INC.
Two Corporate Center Drive, Melville, NY 11747-3157, U.S.A. Tel. 1-800-622-6372

OLYMPUS OPTICAL CO (EUROPA) GMBH.
(Premises/Goods delivery) Wendenstrasse 14-18, 20097 Hamburg, Germany. Tel. 040-237730

(Letters) Postfach 10 49 08. 20034 Hamburg. Germany.
OLYMPUS OPTICAL CO. (U.K.) LTD.

2-8 Honduras Street, London ECTY OTX, United Kingdom, Tel. 020-7253-2772

hﬂp://www.o|ympus.com

Declaration of Conformity

Model Number:
Trade Name:
Responsible Party:
Address:
Telephone Number:

DS-330

DIGITAL VOICE RECORDER
OLYMPUS AMERICA INC.

2 Corporate Center Drive, Melville, NY 11747-3157, U.S.A.

800-622-6372

This device Complies with Part 15 of the FCC Rules. Operation is subject to the following two
conditions: (1) This device may not cause harmful interference, and (2) this device must accept any
interference received, including interference that may cause undesired operation.

C

Tested To Comply
With FCC Standards

FOR HOME OR OFFICE USE

Canadian RFI
This digital apparatus does not exceed the Class B limits for radio noise emissions from digital apparatus
as set out in the Radio Interference Regulations of the Canadian Department of Communications.

Cet apparail numerique ne depasse pas limits de Categorie B pour les emissions de gruit radio emanant
d’appareils numeriques, tel que prevu dans les Reglements sur I'Interference Radio du Department
Canadian des Communications.

“CE” mark indicates that this
product complies with the
European requirements for
safety, health, enviroment and
customer protection.
Lindication “CE” signifie que ce
produit est conforme aux
exigences concemant la sécurité,
la santé, I'environnement et la
protection du consommateur.

Das ,CE“ Zeichen bestatigt die
Ubereinstimmug mit den
Européischen Bestimmungen
fur Betriebssicherheit und
Umweltschutz.

llmarchio “CE” indica che questo
prodotto & conforme alle norme
della comunita europea per
quanto riguarda la sicurezza, la
salute, 'ambiente e la protezione
del consumatore.

La marca “CE” indica que este
producto se encuentra de
conformidad con las exigencias
europeas sobre seguridad,
salud, medio ambiente y
proteccion al consumidor.
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